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OVERVIEW 

INTRODUCTION 
The Outcome Assessment Information Set (OASIS) was developed by the Centers for Medicare & Medicaid 
Services (CMS) to set a standardized protocol for assessing the clinical characteristics of Home Health 
Agency (HHA) patients.  This information is used to better support the regulatory process and policy-making 
by providing survey agencies with a mechanism for objectively measuring facility performance and quality.  It 
also is used to support a prospective payment system for HHAs.  In addition, it provides researchers with a 
rich set of information to support the development of improved standards of care through the study of patient 
care outcomes. 
 
The purpose of the OASIS National Automation Project is to provide computerized storage, access, and 
analysis of the OASIS data on HHA patients across the U.S.  The OASIS System consists of several 
interrelated components, including data communications and an OASIS National Data Repository, and is 
intended to create a standard, nationwide system for connecting HHAs to their respective State agencies for 
the purpose of electronic interchange of data, reports, and other information. 
 
To achieve these goals, CMS has sponsored the development of a data entry system known as the OASIS 
Home Assessment Validation and Entry (HAVEN) System.  HHAs can use HAVEN for collecting OASIS 
data in a standardized format and electronically creating OASIS data records to be sent to State agencies. 
 
As of OASIS Version 1.30 (Reduced Burden) a number of changes to the assessments reduce the number 
of OASIS items required to be entered for some assessment types.  In particular, assessment types 04 
(Recertification) and 05 (Other Follow-Up) include primarily those items required to calculate the HIPPS 
code.  Furthermore, assessment types 02 and 10 have been eliminated. 
 
For Version 9.0, the code was migrated to Visual Basic 2008 in order to take advantage of new accessibility 
features in that development environment.  As a result, HAVEN is now designed to work with external 
screen reader software (e.g., JAWS) for compliance with Section 508.  At the login screen, users have the 
checkbox option to select “enhanced 508 compatibility”.  This option should be checked when an external 
screen reader will be used.  This option also controls the availability of some HAVEN functions.  If a function 
only exists when enhanced 508 compatibility is checked, then it will be described as available only in 508 
mode.  If a function only exists when “enhanced 508 compatibility” is unchecked, then it will be described as 
available only in non-508 mode. 
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CONVENTIONS 
 
Standard conventions have been adopted in the HAVEN System Reference Manual to facilitate locating and 
identifying desired information.  These conventions and their definitions include the following: 
 

Bolded Title Case 
Windows, screen titles, program functions, variable names, and 
dialog boxes (e.g., the HAVEN Patient Information screen). 

Title Case and Italicized Text box or list box descriptions (e.g., the Select an Employee list 
box). 

Title Case Menu options (e.g., the General Help menu option). 
<CAPITALS> Menus, buttons, icons, and function keys (e.g., the HELP menu, 

the <CANCEL> button, the <NOTES> icon, and the <T> key). 
Bolded User entered data (e.g., Enter the password HAVEN). 
 
 
In non-508 mode only, a toolbar is available on the HAVEN Management screen in order to provide quick 
access to common HAVEN functionality.  The user can move the mouse over the icons to see tool tip titles 
describing these functions.  Note that all of the functions on the toolbar are also available on the HAVEN 
Management screen menu. 
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QUICK START 

INSTALLATION AND START UP 
 
This section discusses the following topics: 
 

• Hardware/Software 
• Installation 
• Help 

HARDWARE/SOFTWARE 
 
To operate HAVEN, the following hardware and software are required: 
 

• IBM or IBM-compatible personal computer with Pentium or Athlon processor 
• VGA or VGA-compatible display monitor with a minimum resolution of 800x600 pixels 
• Hard disk with a minimum of 40 megabytes of available space 
• 1 Gigabyte of RAM 
• CD-ROM drive (if installing from CD) 
• Microsoft Windows XP or Vista 
• Microsoft or Microsoft-compatible mouse or pointing device 

 
HAVEN was designed using Super VGA resolution (800x600).  At a lower resolution (e.g., 640x480), all of 
the variables on a given screen may not be visible.  Use the scroll bars to view the entire screen and perform 
data entry. 

INSTALL THE HOME ASSESSMENT VALIDATION AND ENTRY 
(HAVEN) SYSTEM APPLICATION 
 
Detailed installation instructions are contained in README.TXT.  This file is located in the root directory of 
the HAVEN Installation CD.  For the Internet version of HAVEN (downloaded from the CMS OASIS web 
site), extract the contents of the downloaded ZIP file (e.g., SETUPHAVEN10.ZIP) into a temporary directory 
(e.g., C:\TEMP).  This action will decompress all of the installation files as well as README.TXT. 
 
Run the SETUP.EXE program to begin the installation and follow the steps to install the HAVEN program. 
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Operating HAVEN within Large Agencies 
 
HAVEN Version 1.0 was intended to provide software to agencies who either: 1) could not afford to purchase 
software from a vendor and/or 2) did not require a full-featured, client/server application that would be 
integrated with existing systems.  As such, Version 1.0 was designed as a stand-alone application and was 
not intended to run in a network environment.  Version 1.0 was designed to run on the Windows 3.1 platform 
for agencies that could not upgrade to Microsoft Windows 95 or 98. Consequently, HAVEN was built using 
the Visual Basic 6.0 development environment and Microsoft Access 2.0 databases for storage.  These two 
technologies place limits on the software in terms of performance and capacity. 
 
Since the release of Version 1.0, demand for HAVEN by large agencies has increased significantly.  Large 
agencies have requirements that could not be met by Version 1.0; specifically, running in a network 
environment and entering a large number of assessments. 
 
Recent releases of HAVEN were designed to address these two issues as follows: 
 

• The HAVEN storage database can now be located on a shared, network drive.  This capability allows 
multiple installations of the software to perform data entry against the same database.  For more 
information, see the section below titled “Installing HAVEN in a Network Environment.“ 

 
• HAVEN now includes archive/restore functionality.  This functionality alleviates the burden on the 

primary storage database and allows HAVEN to operate in a high-capacity environment.  However, 
this functionality does not operate automatically and requires tasks to be performed by the System 
Administrator.  For more information, see the section titled “Archive Setup.“ 

 
• HAVEN can utilize Microsoft Access 2.0, Access 97 or Access 2000 databases; however, HAVEN 

does not currently support Microsoft Access 2007 or higher databases. 
 

• HAVEN now includes the ability to search for patients and assessments by Branch ID.  Large 
agencies that use branches can take advantage of this to search for the applicable data. 

 
Nevertheless, HAVEN should not be mistaken for a network application.  HAVEN is still a stand-alone 
application, but now contains features that make it possible to operate in a network environment, under 
limited circumstances.  Microsoft Access is not a full-featured Relational Database Management System 
(RDBMS).  Although steps were taken to address collisions in the software, collisions that cause application 
errors may still occur.  In addition, a high number of records in the storage database will degrade the 
performance and reliability of the system. 
 
To ensure the best possible operation of HAVEN under a network environment and limit the number of 
collisions against the database, the following steps should be taken: 
 

• Assign one user to perform all data entry for a particular patient; 
 

• Assign one user to perform all maintenance of the patient information including the adding and 
deleting of patients; 

 
• Assign one user to perform all maintenance of the agency and employee information; 

 
• Assign one user to perform all imports and exports; 

 
• Assign one user to perform all archiving and restoring; 

 
• Assign one user to create all reports; 
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• Do not perform maintenance on the patient, employee, and agency information while other users are 
performing data entry; 

 
• Do not perform imports and exports while other users are performing data entry; 

 
• Do not perform archiving and restoring while other users are performing data entry; and 

 
• Do not perform report creation while other users are performing data entry. 

 
• Utilize the Archive/Restore functionality regularly to alleviate the burden on the storage database.  In 

addition, be certain to compact the storage database (HHA.MDB) after every archive. 
 
• If applicable, use the Branch ID filter ability to simplify access to the applicable patients and/or 

assessments. 
 

Installing  HAVEN in a Network Environment 
 
Several steps should be followed when installing HAVEN in a network environment.  These steps are: 
 

• For the first PC, install the HAVEN software.  First-time users should then utilize the Location tab in 
the HAVEN Preferences screen to specify the location of the HHA.MDB and EMP.MDB files on a 
shared network drive. If the HHA.MDB and/or EMP.MDB are not found in the specified location, they 
will be copied from the application directory.  However, if the HHA.MDB and/or EMP.MDB already 
exist in the specified location, they will be used by HAVEN. 

 
• For each subsequent PC, install the HAVEN software. Run HAVEN.  On the Preferences screen, 

click on the Location tab and enter the HHA.MDB location.  Restart HAVEN and confirm that the 
software is utilizing the shared HHA.MDB and EMP.MDB. 

 
When setting up a network configuration, a shared drive on a network file server MUST be used.  Do not use 
a shared local drive on a PC since a peer-to-peer configuration is not supported. 

HELP 

General/About Help 
 
The General Help provides HAVEN system help regarding how to use and maintain the HAVEN software.  
About help identifies HAVEN software and dictionary information.  From the HAVEN Management Screen 
or any of the HAVEN Data Entry screens, click on the HELP menu and select either the General Help or the 
About options. 
 
 

Additional Help 
 
Context sensitive help is available from any window by pressing the <F1> key.  Individual variable help is 
also available (on data entry screens) by right mouse clicking anywhere within a variable's frame on the data 
entry screens. 
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LOG IN 
 
The user can log in to the HAVEN software by entering the user identification and password in the User ID 
and Password text boxes, respectively, and clicking the <Log in> button or pressing the <ENTER> key. To 
exit the HAVEN Login screen without actually logging in to the system, click on the <EXIT> button. 
 
NOTE:  To enable 508 mode, select the Enable improved 508 compatibility checkbox and make sure it 
is checked!  This checkbox is located after the password field, so 508 users should tab to it after 
entering the password INSTEAD of pressing the <ENTER> key.  After checking the checkbox, the 508 
user may then tab to the <Log in> button and press the space bar. 
 

USER IDS 
 
Use the following Login identification and password for HAVEN the first time: 
 

• User ID HAVEN and password HAVEN are the defaults. 
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HAVEN PATCHES 
 
The HAVEN Patches screen will be displayed if HAVEN detects that a patch is required.  Click on the <OK> 
button to execute the patches or click on the <CANCEL> button to exit HAVEN. 
 
It is highly recommended that a backup of the HAVEN databases be performed prior

 

 to execution of these 
patches. Click the <CANCEL> button if any uncertainty exists about whether the data was saved and 
perform a backup procedure.  Users can then re-enter HAVEN and click the <OK> button on the HAVEN 
Patches screen. 

After the patches are completed, review the items in the Status Messages box for additional information on 
the nature of the patches.  Click on the <PROCEED> button to continue into HAVEN. 

DATABASE MAINTENANCE 
 
For a new HAVEN installation, a message box will be displayed, informing the user that Agency information 
must be entered before any other functions can be utilized.  From the ADMINISTRATION menu item, select 
the Maintain Agency Database option.  Once the HAVEN Agency Information screen is completed, the 
user Login identification and password can be added, modified, or deleted by using the Maintain Employee 
Database feature within the HAVEN software. 
 
After installation, it is recommended that the System Administrator log in first, using HAVEN as both the User 
ID and password.  After completing the Agency information, the System Administrator should establish a new 
User ID and Password for the System Administrator account.  This step can be accomplished by using the 
Maintain Employee Database function described in System Setup.  The HAVEN account should then be 
deleted to ensure the security of the HAVEN software. 
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SYSTEM SETUP 

MAINTAIN AGENCY DATABASE 
 
The Agency Database collects agency and agent information.  It is accessed from the main menu by 
selecting the ADMINISTRATION menu item and then choosing the Maintain Agency Database option.  In 
non-508 mode, users may alternatively click on the <MAINTAIN FACILITY DATABASE> icon. 
 
The HAVEN Agency Information screen collects agency and agent information used to customize the 
operation of the HAVEN software.  It is recommended that a user with System Administrator rights complete 
this information after installation.  This screen is divided into two tabs: Agency Information and Agent 
Information. 

AGENCY INFORMATION 
 
The Agency Information section enables the user to specify unique agency-identifying information such as 
Agency Name, Address, Contact Person, and Medicare, Medicaid, and State-specified provider numbers.  
Fields shown in bold are required. 
 
When an assessment is created, three agency fields are copied from the agency database into the 
assessment record.  These four fields are: Agency State Assigned Unique ID; Agency CCN (formerly 
Medicare Provider Number) (M0010); and National Provider ID (NATL_PROV_ID).  Because agency 
information can be edited at any time, the existing assessment records (except non-key field corrections) are 
not automatically updated when changes are made to the Agency fields.  However, HAVEN will ask the user 
whether all non-exported assessments should be updated.   
 
HAVEN will first ask if the Agency fields should be updated.  It is recommended that this update be 
completed to maintain the integrity of the export files.     
 
Upon entering a Zip Code for Agency and Agent Information, the city and state will be automatically looked 
up if a valid Zip code is entered.  The state will be automatically entered into the state field.  As the user 
types a city name, HAVEN will suggest a complete city name matching the text already entered, assuming 
the user has entered a valid city for the current zip code.  If needed, users may override these values. 

AGENT INFORMATION 
 
The Agent Information section collects unique agent data such as tax identifier, name, address, and phone 
number. 
 
The Agency Information and Agent Information data are included as header information for each export from 
the HAVEN software.  Information about HAVEN export capabilities is provided in the Export Section. 
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MAINTAIN BRANCH DATABASE 
 
The Branch Database collects branch information.  It is accessed from the main menu by selecting the 
ADMINISTRATION menu item and choosing the Maintain Branch Database option.   
 
The HAVEN Select Branches screen allows the user to specify a default Branch ID for assessments when 
they are created from the HAVEN Management Screen.  The user may select N, P, or a specific branch as a 
default value, or the user can specify that no default value be populated in a new assessment.  NOTE:  This 
default value is used when the user has not

 

 filtered by a specific branch on the HAVEN Management 
Screen, i.e., the user has <Everything>, <All Branches>, or <No Branches> selected in the Branch dropdown 
list on the HAVEN Management Screen. 

The HAVEN Select Branches screen also allows the user to add a new branch, delete a branch or edit data 
for an existing branch.  This screen will be automatically populated with Branch IDs (M0016_BRANCH_ID) 
from existing assessments that are imported, added during assessment data entry, archived, or present in 
assessments when the Branch database is first added. 
 
The user can add a new branch (or edit an existing branch) using the HAVEN Edit Branch Information 
screen.  On this screen the user can enter the branch id (M0016_BRANCH_ID).  A default Branch State 
(M0014_BRANCH_STATE) can also be entered.  This state will be used to populate 
M0014_BRANCH_STATE when a new assessment is added. 
 
A descriptive branch name and notes can be entered for each branch.   
 
If a new Branch ID is added, the user will be given the option of updating all of the non-exported and non-
completed assessments with the new Branch ID.   
 
Branches will always be available for selection, provided they exist in at least one assessment. 
 
A branch can only be deleted if that branch is not being used on any
 

 assessment. 

Note:  Users do not need to maintain the branch database using the above features.  They can continue to 
maintain branches as before using data entry of the assessments in data entry.  When a new Branch ID is 
added during assessment data entry, it will automatically be added to the branch database.  This flexibility is 
there for convenience and to maintain consistency with older versions. 
 

MAINTAIN EMPLOYEE DATABASE 
 
The Employee Database provides centralized management of employee records that will be used 
continuously in the entry of assessment data.  From the HAVEN Management screen, select the Maintain 
Employee Database option from the ADMINISTRATION menu item.  In non-508 mode, users may 
alternatively click on the <MAINTAIN EMPLOYEE DATABASE> icon. 
 
Note that this screen is only accessible to users with System Administrator rights.  After installation, the user 
(authorized as System Administrator) will want to define the expected users of the HAVEN software.  The 
Maintain Employee Database screen is used to add, edit or delete employee identification and 
authorization information.  As of Version 10.0, HAVEN began encrypting employee passwords and storing 
employee data in a separate database (EMP.MDB).  This database is located in the same directory as 
HHA.MDB. 
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The Select an Employee section contains a list of employees defined in the database.  The list fields include: 
User ID; On (* indicates the employee is currently logged in); Login Time; Location; Phone; Patient, 
Assessment the employee is working on (if the user is logged in), and the Status of the assessment for all 
employees currently defined in the database. 
 
When the user selects a specific entry from the employee list, the entry is highlighted and the user may now 
perform several functions using the buttons at the bottom of the screen:   
 
The <VIEW DETAILS> button allows the user to view additional data for the currently selected employee 
read-only in the Employee Information pop-up window. 
 
The <NEW> button allows the user to add a new employee record in the Employee Information pop-up 
window.  The employee record contains the following fields: User ID; Password; Title; First Name, Middle 
Initial, Last Name; Access Rights; and Allow Multiple Logins.  The User ID and Password fields must be 
completed.  The Allow Multiple Logins check box allows the user to login using the same Employee ID from 
multiple installations in a network environment.  For stand-alone installations, it is recommended that this 
option be checked.  Upon completion of data entry, click on the <SAVE> button to update the employee 
database.  Saving will also refresh the employee list box on the Maintain Employee Database screen, and 
the new employee will be displayed.  Clicking the <CANCEL> button will abandon the new employee record. 
 
The <DELETE> button allows the user to delete the currently selected employee record. 
 
NOTE: 

Since the System Administrator has access to all functions of the HAVEN software, the user is 
prevented from deleting the last System Administrator record from the database or changing the 
rights (from System Administrator to Data Entry) for the last System Administrator record. 

 
 
The <RESET USER LOGON FLAG> button allows the user to clear the On field (i.e., remove the asterisk) 
for the currently selected employee.  This may be useful if an employee does not exit HAVEN normally (e.g., 
power failure) and is still listed as actively using HAVEN. 
 
The <EDIT> button allows the user to edit the currently selected employee record in the Employee 
Information pop-up window.   The employee record contains the following fields: User ID; Password; Title; 
First Name, Middle Initial, Last Name; Access Rights; and Allow Multiple Logins.  The User ID and Password 
fields must be completed.   The Allow Multiple Logins check box allows the user to login using the same 
Employee ID from multiple installations in a network environment.  For stand-alone installations, it is 
recommended that this option be checked.  Click on the field or checkbox of interest to edit the data.  
Clicking the <SAVE> button will save all changes made to the employee record to the database, while 
clicking the <CANCEL> button will abandon all changes made to the employee record since the last save. 
 
The <CLOSE> button allows the user to close the Maintain Employee Database screen and return to the 
HAVEN Management screen. 
 

MAINTAIN PATIENT DATABASE 
 
The Patient Database provides centralized management of patient information records that will be used 
continuously in the entry of assessment data.  From the HAVEN Management screen, select the Maintain 
Patient Database option from the ADMINISTRATION menu item.  In non-508 mode, users may alternatively 
click on the <MAINTAIN PATIENT DATABASE> icon. 
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The Maintain Patient Database screen displays a list of patients stored in the HAVEN database.  For each 
patient, information is collected that is reused in HAVEN assessments.  This screen consists of two sections:  
the Search and Filter section and the patient list section. 
 
The Search and Filter section allows the user to restrict the patients displayed in the patient list to those 
matching specified criteria.  The user may search the patient database by first selecting the Search tab, then 
choosing the field to search (last name, Social Security Number (SSN), Medicare number, Medicaid number, 
or Patient ID) in the Search drop-down combo box.  The user may then enter a value in the search text field 
and click the <SEARCH> button.  All patients containing a value matching the search value in the specified 
field will be displayed in the patient list below.  
 
For Social Security Numbers, please enter digits only.  Do not enter dashes. 
 
Please note that matches are based on the patient field containing the search text as the beginning of the 
field.  For example, if the user searches by last name for the value “SMITH”, then the patient list will contain 
all users with last name “SMITH” and those with last name beginning with “SMITH” (e.g., “SMITHERS”). 
 
The user may want to reduce the number of patients available from which to choose by filtering on Branch.   
The user may filter the patient list by first selecting the Filter tab, then entering a value in the filter text field 
and click the <FILTER> button.  All patients containing a value matching the search value in the Branch field 
will be displayed in the patient list below.  Note that the user can filter by branch without performing a search 
first.  Also, note that the branch value used to match for a patient is the most recent branch in an assessment 
for that patient. 
 
In order to display the complete list of patients,  clear the Search text and Filter text fields, then click either 
<SEARCH> or <FILTER>. 
 
Two additional checkboxes are available which affect the contents of the patient list:  the View Archived 
Patients and the View Hidden Patients checkboxes.  By default, archived and hidden patients are not 
displayed in the patient list.  Checking the checkbox for either or both of these options will refresh the patient 
list accordingly.  Patients can be specified as hidden in the Patient Information window.  Patients are flagged 
as archived when the <ARCHIVE PATIENT> function on the HAVEN Management screen is used 
successfully. 
 
After searching and/or filtering, the patient list will contain patients in the database meeting the specified 
criteria.  By default, the patient list is displayed in alphabetical order.  Use the scroll bars on the Patient list 
box (or the arrow keys) to navigate the list box and view the available patients.  Click or use the spacebar on 
a row to select a patient. 
 
Users can also sort by any field in the patient list by clicking on the column header.  Clicking once on the 
column header will sort the list in ascending order.  Clicking on the column header again will sort the list in 
descending order.  Alternatively, use Ctrl-Alt-Z when the patient list has the focus.  A context menu will 
appear containing the list of columns that can be selected for sorting. 
 
When the user selects a specific entry from the patient list, the entry is highlighted and the user may now 
perform several functions using the buttons at the bottom of the screen:   
 
The <VIEW DETAILS> button allows the user to view additional data for the currently selected patient read-
only in the Patient Information pop-up window.  The Patient Information window consists of data entry 
fields for demographic and identification information such as gender and race/ethnicity.  
 
The <NEW> button allows the user to add a new patient record in the Patient Information window.  The 
information collected here will be utilized to pre-fill the corresponding fields on the HAVEN assessment forms 
for the selected patient.  Fields shown in bold are required to complete and export HAVEN assessments.  
Upon completion of data entry, click on the <SAVE> button to update the patient database.  Saving will also 
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refresh the patient list box on the Maintain Patient Database screen, and the new patient will be displayed.  
Clicking the <CANCEL> button will abandon the new patient record. 
 
The <DELETE> button allows the user to delete the currently selected patient record.  Please note that a 
patient cannot be deleted if assessments exist in the HAVEN database for the patient. 
 
The <EDIT> button allows the user to edit the currently selected patient record in the Patient Information 
window.   Click on the field, radio button, or checkbox of interest to edit the data.  Please note the Mark 
Patient as Hidden checkbox.  If this checkbox is checked, the patient will not be displayed in the patient list 
by default.  However, the patient and associated assessments will still exist in the HAVEN database.   
Clicking the <SAVE> button will save all changes made to the patient record to the database, while clicking 
the <CANCEL> button will abandon all changes made to the patient record since the last save. 
 
The <Close> button allows the user to close the Maintain Patient Database screen and return to the 
HAVEN Management screen. 
 
When an assessment is created, all of the patient fields are copied from the patient database into the 
assessment record.  Since patient information can be edited at any time, the existing assessment records 
are not automatically updated.  When changes are made to any of the patient fields, HAVEN will ask the user 
whether all non-exported assessments (except for non-key field correction assessments) should be updated.  
It is recommended that this update be completed to maintain consistent patient information across 
assessments in the export files. 
 
NOTE:  If the Patient ID Number (M0020) is changed for each new episode, it is recommended that the user 
NOT update all un-exported assessments (except for non-key field correction assessments) unless they are 
associated with that episode.  For example, if 10 assessments exist for an episode with a Patient ID Number 
of 12345A and a new episode starts and the Patient ID Number is changed from 12345A to 12345B, the 
existing un-exported assessments (except for non-key field correction assessments) should not be updated 
with the new Patient ID Number. 
 
ZIP codes that (a) are not five or nine digits long, or (b) contain letters, are no longer rejected in the patient 
ZIP code field (M0060); instead a warning is provided to the user.  If letters or a short ZIP code are entered 
and the user clicks on the <SAVE> button, the warning "M0060 Zip Code is not 5 or 9 digits long or 
contains letters.  Do you wish to continue?" appears.  Clicking on the <YES> button allows the user to 
continue and save the entered information.  Clicking on the <NO> button returns the user to the Patien t 
In formation  screen.  Upon entering a valid ZIP Code for Agency and Agent Information, the state will be 
automatically populated.  If needed, users may overwrite the value. 

 
The items M0072 (Primary Referring Physician ID), M0140 (Race/Ethnicity), and M0150 (Current Payment 
Sources for Home Care) were added to the patient information screen in HAVEN Version 6.0 and are now 
tracked by patient.  To help complete these items for patients who already exist, items M0072 and M0140 
are copied during data entry from the assessment if the values for the patient are blank.  HAVEN asks the 
user if M0150 should be updated, since payment sources can vary from assessment to assessment.  If 
Unknown is checked for item M0150, the value will only be copied to Start of Care and Resumption of Care 
assessments, since the Unknown option is inactive for other assessment types.  NOTE:  M0072 is now 
known as M0018 for OASIS-C, so M0018 is now displayed on the Patient Information screen. 
 
HAVEN will not allow duplicate patient records.  Duplicate records are identified by: 
 

• Same first name, last name, date of birth, and gender; 

• Same Medicare or Medicaid number; 

• Same Social Security Number; 
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• Same Patient ID number (M0020); or 

• Same State Provided Patient ID. 

 

ENABLE BACKUP 

HAVEN has the capability to make a backup copy of the data collection databases (e.g., HHA.MDB, 
EMP.MDB, EXPORT.MDB, and the current archive database) each time the user exits HAVEN normally.  If 
these databases are corrupted due to abnormal termination of HAVEN (e.g., power failure, system lockup) 
and cannot be repaired, the System Administrator can copy the backup databases into the installation 
directory and only the last HAVEN session will be lost. 
 
To enable the backup, the System Administrator may select the ADMINISTRATION menu, click on the 
PREFERENCES option, and select the Backup tab on the HAVEN Preferences window.  The user can then 
specify a directory location for the backup files.   
 

NOTE:  The backup directory cannot be the same directory where the application and databases currently 
reside. 

 
As of Version 8.1, a backup path is once again optional.  However, if a backup path has not been entered, 
the user will receive warning messages that a backup path has not been specified when entering and exiting 
HAVEN.  If the user provides a path, then later removes the path, the warning messages will no longer 
appear.  It is strongly recommended that HAVEN users carefully consider their backup options, in hopes 
that there will be no data loss due to PC failures. 
 
Once a path has been specified and HAVEN is exited, the data will be backed up to the designated directory 
in the specified compression format.  If <No compression> is selected, then the files are copied to the 
designated directory.  If <Enable compression of databases to ZIP format> is selected, then a ZIP file named 
HHAMDB.ZIP will be created in the designated directory.  Similarly, if <Enable compression of databases to 
self-extracting EXE> is selected, then an executable named HHAMDB.EXE will be created in the designated 
directory.   
 
NOTE:  The backup process should be completed to a network drive, a removable disk, a CD, or a diskette 
(for smaller files).  If possible, do not backup the files to a user's local hard drive only. 
 
If the backup path is later deleted or renamed (e.g., the directory name is changed/deleted using Windows 
Explorer), HAVEN will notify the user upon exiting the system that the backup failed because the path no 
longer exists.  The user will then be required to specify a valid path in order to exit HAVEN. 
 
NOTE:  The HAVEN Backup capability is no substitute for a comprehensive backup strategy.  It is HIGHLY 
RECOMMENDED that HAVEN users institute a regular procedure of backing up the databases to a reliable 
media (e.g., external hard drive). 
 
NOTE:  For users who upgraded to HAVEN 10.0, a one-time backup of the HHA.MDB was performed at 
startup.  The HHA.MDB was copied to a new subdirectory of its current location, named ONE_TIME.  The 
backup version of the HHA.MDB was named HHABKUP.MDB. 
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WINDOWS SETTINGS 
 
In order to ensure the reliable operation of the HAVEN software, it is imperative that the following Windows 
property be set properly: 
 
NOTE:  For Microsoft Windows XP, and Vista, the Windows Font Size property must be set to “Small Fonts“ 
and not “Large Fonts.“  This property can be found under the Settings tab of desktop properties. 
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HAVEN DATA ENTRY 

HAVEN MANAGEMENT SCREEN 
 
Once HAVEN has been loaded, a number of functions can be performed.  These functions are all activated 
from icons or drop down menus available on the HAVEN Management Screen. 
 
The HAVEN Management Screen consists of the following components: 
 

• Title  Bar.  Displays the title HAVEN Management Screen. 
 
• Menu Bar.  Displays the list of functions that can be performed on the HAVEN Management 

window.  Each function (File, Options, Administration, Help) contains additional options.  These 
options are displayed by using the mouse or by using the function's shortcut key.  The shortcut key is 
the <ALT> key and the underlined letter key, (i.e., the FILE menu option can be accessed by 
pressing the <ALT> key and the <F> key simultaneously).  In addition, key combinations are defined 
for all of the functions available on the menu bar. 

 
• Button  Bar.  In non-508 mode, some of the common functions are available on a toolbar underneath 

the menu bar.  The toolbar is not available in 508 mode. 
 

• Filte r b y Bran ch .  The branch filter dropdown box contains the following values:  <Everything>, <All 
Branches>, <No Branches>, and individual Branch IDs/Names (if they exist in the HAVEN branch 
database).  <Everything> is the default value; when selected, all patients are shown.  If <All 
Branches> is selected, then all patients with assessments at a branch are shown.  If <No Branches> 
is selected, then all patients with assessments at the home agency are shown.  Note that patients 
without an assessment will appear if <Everything> is selected for the Branch.  Also, if the patient 
meets the current selection criteria, all of the patient’s assessments will always be displayed even if 
they have different assessments assigned to different branches. 
 

• Patien t In fo .  Enables the user to select a patient to access his/her assessment history. The list of 
patients is sorted by last name, but can be sorted by any of the column names by clicking on the 
column heading. 

 
• Archive Patient.  Allows the user to archive a patient (and their assessments) to the default archive 

database. 
 
• Restore Patient.  Allows the user to restore a patient (and their assessments) from the default 

archive databases (only available in archive mode). 
 
• Ad d Patien t.  Allows the user to add a patient. 

 
• As s es s ment In fo .  Allows the user to view the history of previous assessments and their status for 

the currently selected patient.  For additional information on the status of assessments, see the 
Assessment Status Screen section. 

 
• Ad d As s es s ment.  Allows the user to add an assessment for a selected patient. 
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• Correc t As s es s ment.  Allows the user to correct an assessment (once it has been Locked 
[Exported]) for a selected patient.  Only a System Administrator has access to this feature. 

 
• Dele te  As s es s ment.  Allows the user to delete the highlighted assessment for a selected patient.  

Only System Administrators have access to this feature. 
 
• Print Report.  Allows the user to print the highlighted assessment. 

 
• Enter Data .  Allows the user to enter data for the highlighted assessment for a selected patient. 

 
NOTE:  When the “Open Archive“ option is selected, this option is set to “View Data“ since the data is “View 
Only“ by default in this mode. 
 

• View Only.  Allows the user to view an assessment for a selected patient in read-only mode. 
 

• HIPPS Grouper.  Allows the user to view the HIPPS category of reimbursement for an assessment.  
Users can view HIPPS categories for assessments with reason for assessment values of 01 - 05. 

 
• Enable  Read  Only.  This checkbox allows the user to enable or disable read-write functionality (e.g., 

when checked, the Enter Data button becomes View Data). 
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FILE MENU 
From under the File menu, the user can access the following functions:  Open Archive and Exit. 

Open Archive 
 
This feature allows the user to switch between Archive Mode and Normal Mode.  When selected, this menu 
choice will switch between checked (Archive Mode) and unchecked (Normal Mode). 
 
When in Archive Mode, the software points to the active archive database (as identified in the Archive Setup 
menu, described later).  This feature allows the user to view the archived patients (and their assessments).  
In addition, the following features are available in Archive Mode. 
 

• Res tore  Pa tien t.  This function restores the patient (and patient assessment) data from the active 
archive database to the HHA.MDB database so the user can access the patient and perform all 
functions in Normal Mode. 

 
• Prin t Report.  This function allows the assessment data entry form to be displayed in a format ready 

to print and save in various file formats. 
 
• View Data .  This function allows the user to view the selected assessment in “View Only“ mode 

using the data entry screens.  If any changes need to be made, the patient should be restored. 
 
• View/Prin t Reports .  This function allows the Assessment Data Entry Report to be produced using 

the archive database. 
 
• HIPPS Grouper.  This function enables the user to view the HIPPS code for the currently selected 

assessment. 
 
These are the only functions available in the Archive Mode, aside from the functions that allow the user to 
search for and select a patient and assessment. 

 
 

Exit 
 
This option allows the user to exit the HAVEN software.  To exit HAVEN, select the Exit button in the lower 
right-hand corner of the HAVEN Management Screen, or select the Exit option from the FILE menu on the 
HAVEN Management Screen. 

The user can also exit HAVEN by selecting the ‘X’ (Close Window) in the upper right hand corner of the 
HAVEN Management Screen. 
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OPTIONS MENU 
From under the Options menu, the user can access the following functions:  Log Off/On, View/Print Reports, 
Import, and Export. 

Log Off/On 
 
This option allows the user to return to the HAVEN Login screen.  From here, the user can return to the 
HAVEN Management Screen or exit HAVEN.  If the user returns to the Login screen, he/she can return to 
the HAVEN system by clicking on the “X“ in the upper right corner of the screen. 
 

User List 
 
This option allows a user to view other users who are logged on and the patient and assessment on which 
they are working.  Select the User List option from the OPTIONS menu to display the User List screen.  The 
User List screen contains the same information as the Maintain Employee Database screen.  The items 
include: User IDs; On* (indicates the employee is currently logged in); Login time; Location; Phone; Patient, 
Assessment that the employee is working on, and the Status of the assessment. 
 
When using HAVEN across a network environment, only one user can access a particular assessment at a 
time.  The User List option displays any users who are currently logged on to the system and the 
assessment each user has open for data entry.  Note that open assessments can also be detected using the 
assessment list on the HAVEN Management screen.  If an asterisk is present in the Open column, then the 
assessment is open for data entry. 
 
NOTE: 
An assessment is "Open" once it is accessed for data entry.  The Open box in the assessment list will only 
contain an asterisk when HAVEN is set up in a multi-user (i.e., network) configuration.  The Open box will be 
empty when a user is working in a stand-alone configuration. 
 
 

View/Print Reports 
 
This feature is discussed in the Reports section. 

Import 
 
This feature is discussed in the Import section. 

Export 
 
This feature is discussed in the Export section. 
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ADMINISTRATION MENU 
 
From under the Administration menu, the user can access the following functions:  Maintain Employee, 
Agency, Branch and Patient Databases; Preferences; Archive Setup; Fix Inactive Fields; List Open 
Assessments; Reset Open Status; Reset Open Status on All Assessments; and Retrieve Patient with Hex 
Format. 
 

Maintain Employee, Agency, Branch and Patient Databases 
 
These maintenance functions are discussed in the System Setup section. 
 

Preferences 
 
Preferences can be specified for assessment data entry and sequencing; the location of the primary HAVEN 
database (HHA.MDB); the default paths for use with import and export files; the operation of the HAVEN 
Backup function; and the desired number of assessments to be contained in a single archive file. 
 

Sequencing Tab 
 
The user can also enable or disable strong enforcement of assessment sequencing under this tab.  
Assessment sequencing rules are enforced in two areas of the software: 1) adding assessments and 2) 
importing assessments.  Strong enforcement prohibits the addition or import of assessments in an order that 
violates the sequencing rules.  If strong enforcement is disabled, then assessments can be added or 
imported in an order that violates the sequencing rules.  The user may also delete more than just the most 
recent assessment. 
 

Location Tab 
 
This feature allows a System Administrator to enter the path where the HAVEN databases HHA.MDB and 
EMP.MDB will be located.  HAVEN will then look for HHA.MDB and EMP.MDB in the path specified.  If the 
HHA.MDB and/or EMP.MDB cannot be found, HAVEN will prompt the user to specify another.  Select the 
“Help Me Find It” button to allow HAVEN to search your local disk for HHA.MDB and EMP.MDB. 
 
In addition, the System Administrator can specify where import files are located and where export files are 
created.  A reports path may also be specified, which is the default location for any reports that are saved as 
external files (e.g., PDF, TXT). 

Backup Tab 
 
HAVEN can backup the data collection databases (HHA.MDB, EMP.MDB, EXPORT.MDB, and the currently 
active archive MDB) when exited normally.  After selecting the Preferences option from the 
ADMINISTRATION menu and clicking on the Backup tab, click the Browse button to select a backup 
location.   To disable the backup process, select the Disable backup checkbox and set the value to checked.     
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NOTE:  The path for the backup process cannot be the same as the HAVEN installation path.  For example, 
if HAVEN is installed to C:\HAVEN, the backup path cannot be C:\HAVEN.  If the path is left blank, the 
Backup function is disabled, even if the Disable backup checkbox is unchecked.  
 
In addition, users may choose to have the backup files compressed.  Use the radio buttons in the 
Compression section to choose one of the following three compression options:  no compression (the 
database files are copied to the backup location); enable compression of databases to ZIP format (database 
files are compressed to HHAMDB.ZIP, located in the backup location), or enable compression of databases 
to self-extracting EXE (database files are compressed to HHAMDB.EXE, located in the backup location). 
 
NOTE:  A complete explanation of the Backup function is available in the System Setup section. 

Other Tab 
 

Specify Location Name and Telephone Number 

 
By specifying a location name and telephone number for this installation of HAVEN, employees who log in 
will be associated with this location.  The User List menu option from the HAVEN Management screen 
displays this information.  After selecting the Preferences option from the ADMINISTRATION menu and 
clicking on the Other tab, type the location name and telephone number of the current installation in the 
Location Name and Telephone text boxes provided. 
 
NOTE: 
 
The location name and telephone number are not displayed for employees unless they are logged in to 
HAVEN. 
 

Enable Warning for Number of Assessments in Archive Database 

By default, HAVEN will not warn the user of the number of assessments contained in an archive database.  
However, HAVEN gives the user the capability to display a warning message when an archive database has 
reached a specific number of records. 
 
After selecting the Preferences option from the ADMINISTRATION menu and clicking on the Other tab, click 
on the Warn if an Archive Database Contains ___ or More Assessments check box to display warning 
messages during the archiving process.  The default value is 1,000 for the number of assessments on which 
to warn.  To change the default number, click in the box and enter the desired number, up to 99,999. 
 

Accessibility Tab 
 

Opening Assessments 

 
By default, a user has the option of accessing an assessment already marked as open for data entry.  
HAVEN has the capability to allow only one user to access an assessment at a time.  This option is useful for 
network environments. 
 
After selecting the Preferences option from the ADMINISTRATION menu and clicking on the Accessibility 
tab, click on the Stop Users from Entering Open Assessments check box.  This selection will prevent multiple 
users from opening the same assessment. 
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General Accessibility 

 
As of version 9.0, HAVEN has been enhanced to work with external screen reader software (e.g., JAWS) for 
Section 508 compliance.  Users can enable improved Section 508 compatibility with the checkbox on the 
Login screen (as discussed earlier) or in the Accessibility tab located on the Preferences screen.  Note that 
in 508 mode, the toolbar and CMS logo on the HAVEN Management screen will be hidden.  Also, all reports 
will be sent to a PDF file and not be presented in the report viewer first.  Furthermore, the user will notice the 
appearance of additional message boxes while operating HAVEN; these are added to aid visually impaired 
users in understanding the current HAVEN status. 
 
In 508 mode, the assessment data entry screens present the variable in a single scrolling column, as 
opposed to the fixed-position multiple columns shown in non-508 mode.  Therefore, for 508 mode, users can 
specify a font size (usually, a larger one) to be used in data entry.  On the Accessibility tab, use the Size 
dropdown to specify a new font size.  The selected font size will then be used to display a sample of the text 
seen by the user in assessment data entry.  To change the font back to the HAVEN default, click the 
<Default> button on the Accessibility tab.  The single scrolling column mode of data entry can also be used 
in non-508 mode by checking the Force Vertical Data Entry Method Always checkbox. 
 
 

UI Tab 
 
A checkbox option has been added to force HAVEN to start with the HAVEN Management Screen 
maximized.  By default, this option is unchecked. 
 
 
 

Archive Setup 
 
One or more archive databases can be used to save archive patients and their assessments.  From the 
Archive Information setup window, the user can create a new archive database, delete an archive database, 
and identify the active archive database. 
 
To create a new archive database, click on the <NEW> button.  Enter up to an eight-character file name in 
the Database Name text box.  The location (path) for the database must be selected using the Browse 
button.  The user must also type in a description of the archive database by entering up to 25 characters in 
the Description text box.  Users can click on the <SAVE> button to create the archive database or click on 
the <CANCEL> button to cancel the creation of the archive database. 
 
If several archive databases have been created, the user can specify a particular archive database by 
selecting it from the list. 
 
An archive database can only be deleted when it is empty (i.e., no records are contained in the database).  
When a selected database displays a record count of zero in the Select an archive database section, it can 
be deleted.  A user might choose to delete an archive database if all of the records contained in it have been 
restored, if it was created in error, or if it was never utilized. 
 
To delete an archive database, select an empty archive database and click on the <DELETE> button.  
HAVEN will verify the deletion.  Click on the <OK> button to return to the Archive Information screen. 
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Only one archive database can be active at a time.  To select the active archive database, highlight the 
databases you want to be active and select the “Make this database the active archive database“ check box. 
 

Fix Inactive Fields 
 
The Fix Inactive Fields feature allows a System Administrator to clear any data entry in inactive fields for a 
particular assessment.  After highlighting an assessment, the System Administrator can select the Fix 
Inactive Fields option from the ADMINISTRATION menu.  HAVEN will review the selected assessment and 
clear any variables that are inactive and should be empty.  When the process is complete, HAVEN will verify 
whether or not any inactive fields were fixed. 
 

List Open Assessments 
 
This feature allows users to view a list of assessments currently marked (*) as open. 
 
When using HAVEN across a network environment, only one user can access an assessment at a time.  The 
List Open Assessments option displays the current user's ID, the patient's name and Social Security 
Number, and the assessment type for each assessment marked as open. 
 
To view the open assessments, click on the ADMINISTRATION menu and select the List Open Assessments 
option.  The HAVEN Open Assessments screen will display the assessments currently open for data entry. 
 
NOTE:  An assessment is considered open while data entry is being performed. 
 

Reset Open Status 
 
This feature allows a System Administrator to reset an assessment's Open status.  The Open status is 
normally reset (the * disappears from the Open box) when a user exits data entry for an assessment. 
 
The Reset Open Status function is especially useful when abnormal termination of HAVEN (e.g., power 
failure, system lockup) occurs.  When HAVEN is restarted, a user cannot access any assessments marked 
as Open.  A System Administrator must reset these assessments before data entry can continue. 
 
To reset the Open status of an assessment, the System Administrator should highlight an assessment that 
needs to be reset, click on the ADMINISTRATION menu, and select the Reset Open Status option.  This 
action will clear the Open box and reset the currently selected assessment.  If more than one assessment 
needs to be reset, highlight the next assessment and repeat the process until all of the desired assessments 
have been reset. 
 

Reset Open Status on All Assessments 
 
This feature allows a System Administrator to reset the Open status of all assessments.  The Open status is 
normally reset (the * disappears from the Open box) when a user exits data entry for an assessment. 
 
The Reset Open Status on All Assessments function is especially useful when abnormal termination of 
HAVEN (e.g., power failure, system lockup) in a network configuration occurs.  When HAVEN is restarted, 
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users cannot access any assessments that are marked as Open.  A System Administrator must reset these 
assessments before data entry can continue. 
 
To reset the Open status of all assessments, the System Administrator should click on the 
ADMINISTRATION menu, and select the Reset Open Status on All Assessments option.  This action will 
clear the Open box and reset all assessments.  
 

Retrieve Patient with Hex Format 
 
The Retrieve Patient with Hex Format feature allows a System Administrator to retrieve patient information 
that has been masked. 
 
To search for a patient in hex format, click on the ADMINISTRATION menu, and select the Retrieve Patient 
with Hex Format option.  System Administrators can search for patient information by entering the hex 
representation of the masked value in one or more of the following fields: the Patient ID Number, Patient 
Name, Medicare Number, Social Security Number, or Medicaid number. 
 
NOTE:  With the release of HAVEN 10.0, private pay assessments were no longer masked and exported 
from HAVEN.  This function remains in HAVEN for backward compatibility. 

HELP MENU 
 
From under the Help menu, the user can access the following options:  General Help and About. 
 

Access General and About Help 
 
General Help provides HAVEN system help regarding how to use and maintain the HAVEN software.  
About identifies HAVEN software and dictionary Version information as well as application and data 
collection database (HHA.MDB) path locations.  From the HAVEN Management Screen or any of the 
HAVEN Data Entry screens, click on the HELP menu and select either the General Help or the About 
options. 
 
Context sensitive help is available from any window by pressing the <F1> key.  Individual variable help is 
also available by right mouse clicking anywhere within a variable's frame on the data entry screens. 

PATIENT INFO 
 
The Patient Info section enables the user to select the patient whose assessment history will be accessed.  
Patients are displayed in alphabetical order by default.  Use the scroll bars on the Patient list box to view the 
available patients and click on the preferred row to select a patient.  After selecting a patient, the 
assessments previously created for the patient will display in the assessment list in the Assessment Info 
section. 
 
The Search and Filter section allows the user to restrict the patients displayed in the patient list to those 
matching specified criteria.  The user may search the patient database by first selecting the Search tab, then 
choosing the field to search (last name, Social Security Number (SSN), Medicare number, Medicaid number, 
or Patient ID) in the Search drop-down combo box.  The user may then enter a value in the search text field 
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and click the <SEARCH> button.  All patients containing a value matching the search value in the specified 
field will be displayed in the patient list below.  
 
For Social Security Numbers, please enter digits only.  Do not enter dashes. 
 
Please note that matches are based on the patient field containing the search text as the beginning of the 
field.  For example, if the user searches by last name for the value “SMITH”, then the patient list will contain 
all users with last name “SMITH” and those with last name beginning with “SMITH” (e.g., “SMITHERS”). 
 
The user may want to reduce the number of patients available from which to choose by filtering on Branch 
ID.   The user may filter the patient list by first selecting the Filter tab, then selecting a branch value from the 
dropdown list, and then clicking the <FILTER> button.  All patients containing a value matching the search 
value in the Branch field will be displayed in the patient list below.  Note that the user can filter by branch 
without performing a search first. 
 
In order to display the complete list of patients,  clear the Search text and Filter text fields, then click either 
<SEARCH> or <FILTER>. 
 
After searching and/or filtering, the patient list will contain patients in the database meeting the specified 
criteria.  By default, the patient list is displayed in alphabetical order.  Use the scroll bars on the Patient list 
box (or the arrow keys) to navigate the list box and view the available patients.  Click or use the spacebar on 
a row to select a patient. 
 
Users can also sort by any field in the patient list by clicking on the column header.  Clicking once on the 
column header will sort the list in ascending order.  Clicking on the column header again will sort the list in 
descending order.  Alternatively, the user can press Ctrl-Alt-Z when the patient list is in focus – a context 
menu will appear containing the list of columns to sort by.  The user may select a column and the patient list 
will be sorted accordingly. 
 

ADD A PATIENT 
 
The <ADD PATIENT> button allows the user with to add a new patient record.  The user must complete the 
fields with labels in Bold before the record can be saved.  Any remaining fields are optional. 
 
To edit, hide, or delete an existing patient record, the Maintain Patient Database option from the 
ADMINISTRATION menu item must be selected.  Refer to the Maintain Patient Database section for a 
detailed explanation of how to add/edit/hide/delete a patient. 

ARCHIVE A PATIENT 
 
The purpose of the Archive feature is to help maintain the size of the system database HHA.MDB.  The 
Archive function allows the System Administrator to archive a patient and his or her associated 
assessments if all of the assessments for that patient have a status of "Exported" or "Completed”.  For 
instance, if a patient is not expected to return to the facility, all of the assessments for the patient can be 
archived for storage purposes, thus reducing the size of the system database HHA.MDB. 
 
To begin the Archive function, select a patient whose assessments have all been exported and click on the 
<ARCHIVE PATIENT> button.  HAVEN will archive that patient's assessments to the active archive 
database.  The System Administrator also has the capability to create an archive database and specify the 
location of that archive database.  Click on the ADMINISTRATION menu item and select the Archive Setup 
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option to display the Archive Setup screen.  See the Archive Setup section for a complete explanation of 
creating an archive database. 
 
NOTE: 
To view archived patient records on the Patient Information screen, click on the ADMINISTRATION menu 
item, select the Maintain Patient Database option, and click on the View Archived Patients check box.  To 
view archived patient records from the HAVEN Management screen, click on the FILE menu item and select 
the Open Archive option. 
 
It is recommended that the system database, HHA.MDB, be repaired and compacted after several archives 
have been performed.  In order to complete the repair/compact process, all users must exit the HAVEN 
software.  See Appendix A for a complete description of executing the Repair/Compact function. 
 

RESTORE A PATIENT 
 
The Restore function allows the System Administrator to reinstate a patient who has been archived and 
removed from the system database HHA.MDB.  To begin the Restore function, select the Open Archive 
option from the FILE menu to display the patients who have been archived in the default archive database or 
in the archive database specified on the Archive Information screen.  All archived patients will be displayed 
on the HAVEN Management screen.  Select a patient and click on the <RESTORE PATIENT> button to 
reinstate that patient.  To close the archive database and display the active patients in the system database, 
HHA.MDB, reselect the Open Archive option from the FILE menu. 
 
While in the Archive mode of HAVEN, the user has limited functionality.  Features include: switching 
between the Archive and Restore functions; the Reports function; accessing Help; and viewing and printing 
assessments. 
 
NOTE:  There have been situations where users have lost their archive databases from their PCs.  Without 
the archive databases, they were unable to restore the patient to the HHA.MDB (in order to add additional 
assessments).  A special function is available to resolve this situation.  On the Maintain Patient Database 
screen, highlight the patient and press Ctrl-R.  This will reset the archive status for the patient.  It is 
STRONGLY RECOMMENDED that this function ONLY be used if the archive database is missing. 
 

ASSESSMENT INFO 
The Assessment Selection section allows the user to view the history and status of previous assessments for 
the currently selected patient.  Assessments are displayed in the order they were added, with the most 
recent assessment displayed first in the list.  For each assessment, the effective date, assessment type, 
status, last user to access the assessment, and a correction number are displayed.  Select an assessment 
by scrolling through the list and clicking on it.  The user can access the selected assessment to perform data 
entry or edits by clicking on the <ENTER DATA> button. 
 
The Add Assessment section also enables the user to initiate a new assessment for the selected patient.  
Click on the <ADD ASSESSMENT> button to access the HAVEN Reasons for Assessment screen 
(described below) before the assessment is added to the patient. 
 
Note the following: 
 

• Newly created assessments have a status of “New“ 
• Edited assessments have a status of “In Use“ 
• Completed Data Entry assessments have a status of “Export Ready“ for non-private pay 
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• Completed Data Entry assessments have a status of “Completed“ for private pay 
• Exported assessments have a status of “Exported“ 
 
 

NOTE:  As of OASIS Version 1.30 (Reduced Burden), assessment types 02 and 10 no longer exist.  
However, these assessment types can be created using the 1.20 specification.  Note that these assessments 
cannot be exported, since the OASIS State System will not accept any 02 or 10 assessments. 
 
NOTE:  If applicable, the selected Branch ID and its associated Branch State will be added to the new 
assessment.  If any of the Branch options <Everything>, <All Branches>, or <No Branches> are selected, 
then the default Branch ID and State entered using the Maintain Branch Database menu option will be used 
(if present). 
 
 

Reason for Assessment 
 
When the user clicks on the <ADD ASSESSMENT> button, the HAVEN Reasons for Assessment screen 
is displayed. 
 
If strong enforcement is disabled, the Reasons for Assessment will be displayed in black or red.  Black 
indicates the user will be adding assessments in sequencing order.  Red indicates the user will be adding 
assessments out of sequencing order. 
 
The response-specific instructions available for an assessment include: 
 
Start/Resumption of Care 
 
• Response 01.  Start of care—further visits planned - This is the start of care comprehensive 

assessment.  A plan of care is being established, and further visits are planned. 

NOTE:  When 01, Start of Care, is selected, the M0030 Start of Care Date must be entered.  The date will be 
tracked across assessments until a new start of care occurs.  The user has the ability to change the date 
during data entry. 
 
• Response 02.  Start of care—no further visits planned - This is the first visit; a comprehensive 

assessment has been performed.  However, no additional visits will be made.  Mark this response if the 
original order is for a one-time visit only.  No additional data will be provided on this patient, as no plan of 
care is established (e.g., a subsequent discharge assessment is not expected).  

 
NOTE:  As of OASIS Version 1.30 (Reduced Burden) this reason type was removed.  However, it is allowed 
using OASIS Version 1.20.  Note that 02 assessments cannot be exported, however. 
 

• Response 03.  Resumption of care (after inpatient stay) - The comprehensive assessment is being 
conducted when the patient resumes care following an inpatient stay of 24 hours or longer. 

 
NOTE:  When 03, Resumption of Care, is selected, the M0032 Resumption of Care Date must be entered.  
This date will be tracked across the subsequent assessments until a new Start of Care or Resumption of 
Care assessment is added. 
 
Follow-Up 
 

• Response 04.  Recertification (follow-up) reassessment - The comprehensive assessment is being 
conducted during the last five days of the certification period. 
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• Response 05.  Other follow-up - The comprehensive assessment is conducted due to a significant 
change in patient condition at a time other than during the last five days of the certification period.  
This assessment is completed to update the patient's care plan. 

 
Transfer to an Inpatient Facility 
 

• Response 06.  Transferred to an inpatient facility—patient not discharged from agency - Data 
regarding the patient's transfer to an inpatient facility for 24 hours or longer (for reasons other than 
diagnostic tests) are reported.  The patient is expected to resume care and is not discharged from 
the agency.  When the patient resumes care, a Resumption of Care comprehensive assessment is 
conducted.  Note the “skip pattern“ that is included in the response.  This response does not require 
a home visit; a telephone call may provide the information necessary to complete the required data 
items. 

 
• Response 07.  Transferred to an inpatient facility—patient discharged from agency - Data regarding 

the patient's transfer to an inpatient facility for 24 hours or longer (for reasons other than diagnostic 
tests) are reported.  The patient is discharged from the agency.  Note the “skip pattern“ that is 
included in the response.  This response does not require a home visit; a telephone call may provide 
the information necessary to complete the required data items. 

 
Discharge from Agency – Not to an Inpatient Facility 
 

• Response 08.  Death at home - Data regarding patient death other than death in an inpatient facility.  
A patient who dies before being admitted to an inpatient facility would have this response marked.  
Note the “skip pattern“ that is included in the response.  A home visit is not required to mark this 
response; a telephone call may provide the information necessary to complete the data items. 

 
• Response 09.  Discharge from agency - The comprehensive assessment is being conducted at the 

patient's discharge from the agency.  This discharge is not occurring due to an inpatient facility 
admission or patient death.  An actual patient interaction is required to complete this assessment.  
Note the “skip pattern“ that is present in the response. 

 
• Response 10.  Discharge from agency—no visits completed after start/resumption of care 

assessment - This response is marked in the event of an unusual occurrence.  The agency visits the 
patient at the start (or resumption) of care and establishes a plan of care.  However, before another 
skilled visit is made, the patient is discharged.  (For example, a family member may move the patient 
to another location.)  This response is not marked at the same time as Response 2; this situation is 
very different.  Note the “skip pattern“ that is included in the response.  This response should not be 
used if the patient is transferred to an inpatient facility or dies at home. 

 
NOTE:  As of OASIS Version 1.30 (Reduced Burden) this reason type was removed.  However, it is allowed 
using OASIS Version 1.20.  Note that a Reason 10 assessment cannot be exported. 

 
Select the OASIS Specification for the assessment being added.  The default is the current OASIS 
specification.  After a selection has been made (one response per assessment), click on the <OK> button to 
save the choice and return to the HAVEN Management Screen, or click on the <CANCEL> button to cancel 
the assessment and return to the HAVEN Management Screen. 
 
NOTE:  As of OASIS Version 1.30 (Reduced Burden), a number of changes were made to the assessment 
to “reduce the burden“ of data entry.  When the user selects Version 1.30 or higher, fewer data entry items 
are required for RFAs 4 and 5, a number of items are removed from all of the assessments, and two 
assessments (RFAs 2 and 10) are no longer valid.  In addition, in Versions 1.30 or higher, a new tracking 
form makes it easier for repeating information to be duplicated on each successive assessment. 
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Sequence of Assessments 
 
In accordance with OASIS Data Specification 1.50 (and 1.40), the sequence of assessments for a patient 
should conform to certain requirements.  These requirements are described below: 
 

• After adding RFA (Reason for Assessment) 1, the user may add RFA 4, 5, 6, 7, 8, or 9; 
 

• After adding RFA 3, the user may add RFA 4, 5, 6, 7, 8, or 9; 
 

• After adding RFA 4, the user may add RFA 4, 5, 6, 7, 8, or 9; 
 

• After adding RFA 5, the user may add RFA 4, 5, 6, 7, 8, or 9; 
 

• After adding RFA 6, the user may add RFA 1, 3, 4, 5, 7, 8, or 9; 
 

• After adding RFA 7, the user may add RFA 1, 3, 4, 5, 6, 8, or 9; 
 

• After adding RFA 8, the user cannot add any RFA record; and 
 

• After adding RFA 9, the user may add RFA 1. 
 
For more information on sequencing enforcement, see the Preferences section. 
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Effective Date of Assessment 
 
After an assessment is added, the Effective Date for the assessment will be blank.  Following is a list of the 
assessments and the date variables that need to be completed in data entry before the Effective Date will be 
displayed on the HAVEN Management Screen. 
 

• Start of care—further visits planned M0030_START_CARE_DT (Start of care date) 
 

• Start of care—no further visits planned M0030_START_CARE_DT (Start of care date)* 
 

• Resumption of care (after inpatient stay) M0032_ROC_DATE (Resumption of care date) 
 

• Recertification (follow-up) reassessment M0090_INFO_COMPLETED_DT (Date assessment 
completed) 

 
• Other follow-up M0090_INFO_COMPLETED_DT (Date assessment completed) 

 
• Transferred to an inpatient facility—patient not discharged from agency M0906_DC_TRAN_DTH_DT 

(Discharge/transfer/death date) 
 

• Transferred to an inpatient facility—patient discharged from agency M0906_DC_TRAN_DTH_DT 
(Discharge/transfer/death date) 

 
• Death at home M0906_DC_TRAN_DTH_DT (Discharge/transfer/death date) 

 
• Discharge from agency M0906_DC_TRAN_DTH_DT (Discharge/transfer/death date) 

 
• Discharge from agency—no visits completed after start/resumption of care assessment 

M0906_DC_TRAN_DTH_DT (Discharge/transfer/death date)* 
 
*Although these types of assessments can no longer be created or exported, it is still possible to complete 
data entry for these assessments. 
 
The date displayed with each assessment on the HAVEN Management Screen will not be visible until the 
effective date is determined. 
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Correct an Assessment 
 
Once an assessment has been Locked (Exported), only a System Administrator has access to it.  Listed 
below are the three supported types of corrections: 
 

• As s es s ment was  s ubmitted  to  the  Sta te  and  was  re jec ted .  By selecting this option, the 
assessment lock dates are cleared and the user is taken directly into data entry for that assessment.  
After the necessary corrections are made, the assessment can be completed, locked, exported, and 
re-submitted to the State. 

 
• As s es s ment was  s ubmitted  to  the  Sta te  and  was  accep ted .  Correc tion  to  n on -key fie ld s  on ly 

is  neces s a ry.  To correct an assessment with non-key field errors in the assessment, a copy of the 
assessment is made and the correction number is incremented by one.  After the corrections are 
made, the assessment can be exported. (This is no longer a valid type of correction.  Use 
inactivation of the assessment instead.) 

 
• As s es s ment was  s ubmitted  to  the  Sta te  and  was  accep ted .  Correc tion  to  non-key fie lds  is  

neces s ary.  To correct an assessment with non-key field errors in the assessment, a copy of the 
assessment is made and the correction number is incremented by one.  After the corrections are 
made, the assessment can be exported. 

 
• As s es s ment was  s ubmitted  to  the  Sta te  and  was  accep ted .  Inactivation of the assessment is 

necessary.  By selecting this option, a copy of the assessment record is created.  The user is taken 
directly into data entry for that assessment, however the entire assessment is view-only.  After 
viewing the assessment, the user can exit the assessment.  The correction number on the HAVEN 
Management screen and the assessment status will be “Export Ready.“ 

After exporting an inactivation record, a new assessment containing the data from the inactivated 
assessment can be created.  Select the inactivation record from the HAVEN Management screen and click 
on the <CORRECT ASSESSMENT> button.  The HAVEN Data Entry System pop-up box will appear.  Click 
on the <OK> button to create the assessment pre-populated with the data from the inactivation record.  The 
correction number for this assessment will be 00. 
 
If corrections are done for a submitted assessment from a prior version of HAVEN, the prior version will be 
used for an error check. 
 
For further information on OASIS correction procedures, see the OASIS Data Submission Specifications link 
available from CMS at http://www.cms.hhs.gov/oasis. 
 

Delete an Assessment 
 
Only a System Administrator may delete an assessment.  To delete an assessment, select the assessment 
and click on the <DELETE ASSESSMENT> button.  The user will receive two messages asking for 
verification before the assessment will be deleted from the database.  Note that once an assessment is 
deleted from the database, it cannot be recovered. 
 
Because of the sequencing requirements, assessments may be deleted from the top down only.  Start with 
the first number in the Select/Add an Assessment for Patient text box and delete the necessary assessment 
records.  As records are deleted, the assessments are automatically renumbered. If strong enforcement is 
disabled, this restriction does not apply and the user may delete any assessment. 
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Print an Assessment 
 
Select the <PRINT ASSMT> button to print the currently selected assessment.  Once selected, the user can 
choose to display all the sections or a subset of the OASIS data entry sections.  Selecting the <CANCEL> 
button will stop the print process.  When the assessment report is completed, it will appear in the Report 
View window.  From the window the user has the option to print the report as well as save it in .PDF (Adobe 
Acrobat), .RTF (Rich Text Format), or .TXT (Text) format. 
 

Enable Read Only 
 
If the Enable Read Only option is checked, the user is allowed to view an assessment in read-only mode.  
This option is useful for reviewing the data entered and ensuring that no data are accidentally edited. 

EXIT 
 
The user may exit the HAVEN software by clicking on the <EXIT> button or by selecting the FILE menu item 
and clicking on the Exit option. 



HAVEN Reference Manual: October 1, 2010 HAVEN Data Entry  35 

HAVEN DATA ENTRY WINDOW 
 
The Data Entry screen typically consists of the following components: 
 

• Title  Bar.  Displays HAVEN Data Entry along with the assessment type (Original, Modification or 
Inactivation), the patient first and last names, the patient SSN, and the patient Date of Birth. 

 
• Menu Bar.  Displays the list of functions that can be performed on the Data Entry screen.  Each of 

these functions contains additional options that can be displayed by using the keyboard or mouse. 
 

• Data  Entry Button  Bar.  Provides the available Data Entry functions.  Currently, four functions are 
available: Previous, Next, Exit (Validate) and Exit (No Validate).  All of these functions also exist 
on the Menu Bar. 

 
• Go To Dropdown Box.  Contains a list of screens for the selected set of screens.  When the box is 

dropped down, the user can navigate the list of screens with either the up and down arrow keys or 
the left and right arrow keys.  If a screen is clicked with a mouse or selected by pressing the Enter 
key, the Data Entry screen of the selected screen will open in the space below it. 

 
• Data  Entry Screen .  Contains variables that belong to the selected screen.  On this screen, data 

entry can be performed for each variable. 
 

• Font Size .  In vertical (i.e., single column) data entry, the font size may be adjusted by entering a 
size between 8 and 28 in the Size textbox.  Alternatively, the user can press F11 to decrease the font 
size by one, or press F12 to increase the font size by one. 

 
 

ENTER DATA FOR A VARIABLE 
 
Perform data entry after selecting a Patient record and an Assessment form.  (See previous sections: 
Select/Add a Patient and Select/Add/Edit/Correct/Delete an Assessment.)   
 
Data entry can be exited at any time by selecting the Exit (Validate) or Exit (No Validate) buttons, or by 
clicking on the File menu item and selecting the Exit (Validate) or Exit (No Validate) items.  If Exit (Validate) 
is selected, HAVEN will perform error checks for the current set of assessment values. If errors are found, 
they will be displayed on the Assessment Validation Warnings screen.  This screen is described below.  If 
Exit (No Validate) is selected, the data entry screen will close immediately and the user will be returned to 
the HAVEN Management Screen. 
 
To begin data entry, select the desired screen using the <PREVIOUS> button, the <NEXT> button, or the Go 
To Dropdown Box.  Follow the descriptions below to enter data for the various variable types. 
 

Option (Pick One) 
 
The variable type Option (Pick One) includes the items from which only one item can be chosen.  Choose 
an item by selecting the radio button or check box (if the Check Boxes option has been selected from the 
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Preferences menu) next to the item.  Users may clear radio buttons by clicking on the <RIGHT MOUSE> 
button and selecting the Clear Variable option. 

Option (Pick One or More) 
 
 
The variable type Option (Pick One or More) includes options from which one or more items can be 
chosen.  Choose the item(s) by marking the check box next to the desired item.  Note that, normally, the last 
item on the list (usually None of the Above) clears all the other items.  
 
Check boxes have two possible states: checked and unchecked.  Checked indicates that the option is true.  
Unchecked indicates that the option is false or not applicable. 

 

Date 
 
The variable type Date accepts data entered in the date format that has been specified in the design (the 
default format for date is MM/DD/YYYY).  
 

String 
 
The variable type String accepts text entered in any alphanumeric combination.  The string is limited in 
length by variable type. 
 

ICD-9 
 
The ICD-9 variable type allows the user to select a Diagnosis or Procedure code by clicking on the ICD-9 Dx 
or ICD-9 Pr button respectively, which displays the ICD-9 Codes window.  In this window, the user can 
search for a code by typing the code into the Search on Code text box (the codes will be displayed 
automatically) or by typing a description into the Search by Description text box.  As entries are made into 
either search box, the list of ICD-9 codes/description matching the pattern entered will appear in the list 
below.  To select an ICD-9, the user can check (highlight) the code of interest and select the <OK> button, or 
simply double-click the desired code. 
 

SPECIAL FEATURES (HAVEN DATA ENTRY SCREEN) 

Enter Notes 
 
To enter a general note about a variable during data entry, use a right-click to generate a context menu (or 
press the asterisk key on the keyboard).  The displayed pop-up box allows the user to enter a note 
containing up to 32,000 alphanumeric characters.  Since all of the notes for a given assessment are stored in 
one file, copying the Variable Screen Title before writing a note provides a good reference point to the 
variable.  To paste the screen title of the current variable into the note, select the <COPY TO NOTES> 
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button.  Click on the <SAVE> button to save the notes; click on the <CLOSE> button to return to the Data 
Entry window. 
 

Clear Value on a Variable Radio Button 
 
To clear variables with radio buttons, click on the <RIGHT MOUSE> button (or press the asterisk key on the 
keyboard) and select the Clear Variable option. 
 

View Help 
 
To display the Help available for each variable, click on the <RIGHT MOUSE> button while the mouse is on 
the variable label, or press F1 while a variable has the focus. 
 

Print Screen 
 
Selecting the Print Screen option from the File menu item allows the user to print the current screen.  If the 
screen does not print properly (possibly due to the default printer settings), another process, screen 
capturing, is available. 
 
There are several steps to follow when capturing a screen in design or data entry for printing.  To copy a 
screen, press on the <PRINT SCRN> button or press on the <ALT> + <PRINT SCRN> buttons to capture 
only the active window.  After opening a word processing package such as Word or a graphics package such 
as Paint, paste the screen into the document by pressing on the <CTRL> + <V> buttons.  The screen can 
also be copied into a document by using the paste function available in the application being used. 
 

Edit Agency Data 
 
During data entry, the user has access to the HAVEN Agency Information screen from the Edit menu 
items.  This feature allows the user to edit the Agency Information for an assessment.  For example, if 
incorrect information is added during the setup process for the agency, the user can edit this information 
during the data entry process.   
 

Edit Branch Data 
 
During data entry, the user has access to Branch State (M0014) and Branch ID (M0016) variables for entry 
or modification.  If the user creates a new Branch ID here, it will be automatically added to the Branch 
database when data entry is exited.  Note that the user can use Ctrl-C (copy) and Ctrl-V (paste) to copy a 
Branch ID from the list into M0016_BRANCH_ID.  The list of Branch IDs on the HAVEN Management 
Screen will always display all of the unique Branch Ids in the assessment database.   
 

Edit Patient Data 
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During data entry, the user has access to the HAVEN Patient Information screen from the Edit menu items.  
This feature allows the user to edit the Patient Information for an assessment.  For example, if incorrect 
information is added during the setup process for the Patient database, the user can edit this information 
during the data entry process. 
 
After saving the edited information, HAVEN will ask the user whether all non-exported assessments (except 
for non-key field correction assessments) should be updated.  It is recommended that this process be 
completed to maintain consistent patient information across assessments in export files.  The user may 
choose not to update any unexported assessments (except for non-key field correction assessments) and 
HAVEN will still update the current assessment. 
 
The Edit Patient Data menu item is not available during data entry for non-key field correction assessments, 
since changes to patient information would result in non-key changes. 
 
NOTE:  When editing the HAVEN Patient Information screen during data entry, only the Patient Information 
portion of the screen will be visible.  The user cannot search for or select another patient. 
 

CALCULATE/VIEW HIPPS (IF APPLICABLE) 
 
HIPPS calculations are automatically performed for an assessment when the data entry for the assessment 
has been completed and its status is made “Export Ready.“  HIPPS can be calculated for assessments with 
RFAs 1-5.  The HIPPS can be recalculated at any time during data entry.  Click on the HIPPS menu item in 
data entry to recalculate the HIPPS.  The View HIPPS screen will be displayed.  Note, however, that the 
HIPPS values are not saved until the assessment is locked. 
 
HIPPS can also be viewed from the HAVEN Management Screen using the <HIPPS GROUPER> button.  If 
the assessment status is “Exported,“ the HIPPS have already been calculated and will merely be displayed 
in the View HIPPS screen; otherwise, the HIPPS will be recalculated and then displayed. 
 

ASSESSMENT VALIDATION AFTER EXIT 
 
When the user attempts to exit data entry, the system will check all of the rules in place.  One such rule is the 
mandatory variable rule.  All mandatory variables must have valid data values.  If a mandatory variable is left 
blank (i.e., data are not entered), the user will be warned that this variable is mandatory (e.g., ERROR: Is 
Blank But Should Not Be: (M0030_START_ CARE_DT - Start of Care Date)).  The user will not be able to 
mark an assessment as complete until all mandatory variables have been entered. 
 
In addition, any assessment validation warnings will be displayed.  Since these warnings are for 
informational purposes and are not considered errors, they are not required to be resolved before an 
assessment can be marked as complete. 
 
If an assessment contains errors, the Assessment Validation Warnings screen will be displayed.  This 
screen contains a list box of all errors detected during the validation process.  As the user selects an error 
entry from the list box, a full description of the error is displayed in the text box below.  Messages marked as 
“FATAL” are errors not addressable by data entry personnel.  These errors should be referred to the System 
Administrator.  
 
There are four buttons at the bottom of the Assessment Validation Warnings screen.  Clicking on the <GO 
TO SCREEN WITH ERRORS> button will return the user to the HAVEN Data Entry Window and 
automatically display the screen containing the variable selected in the errors list box.  Clicking on the 
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<PRINT ERRORS> button will print the errors/warnings listed in the errors list box.  Selecting the 
<CONTINUE> button will take the user to the Assessment Status screen where the assessment can be 
exited by marking it as complete, admission complete or in use.  Choosing the <RETURN TO DATA 
ENTRY> button will allow the user to continue the data entry process. 
 

ASSESSMENT STATUS WINDOW 
 
On the Assessment Status screen, the status of an assessment must be marked before the assessment 
can be exited. 
 
The various options that can be selected when exiting the Assessment Status screen include: 
 

• Case in active use: An assessment has been edited but is not complete 
 

• Completed: Data entry has been completed for an assessment (both admission and discharge 
variables) 
 

 
To mark the status, select the best choice and press the <OK> button.  The HAVEN Data Entry Window will 
close and the HAVEN Management screen will reappear.   To return to data entry and the HAVEN Data 
Entry Window, click the <CANCEL> button. 
 
NOTE: 
Once an assessment has been marked "Exported", only users with System Administrator rights can reopen 
it. 
 
 

OASIS PATIENT TRACKING DATA 
 
As of OASIS Version 1.30 (Reduced Burden), a new patient tracking form was used for each assessment.  
The intention of the tracking form is to keep track of key information that does not change frequently between 
assessments, such as the patient’s race/ethnicity.  Many of these patient items were being tracked across 
assessments by HAVEN.  However the following items were added in HAVEN Version 6.0 and are now 
tracked: 
 

• M0030 (Start of Care Date);  
• M0032 (Resumption of Care Date or Not Applicable); 
• M0072 (Primary Referring Physician ID or Unknown or Not Available); 
• M0140 (Race/Ethnicity); and 
• M0150 (Current Payment sources). 

 
These variables are tracked for each patient from the most recent assessment.  For example, if the user 
updates M0140 on the current assessment, the values become the default M0140 values tracked for the 
patient (if the user chooses).  The one exception is M0150; if this variable is changed, HAVEN asks the user 
if the patient database should be updated.  It is expected that M0150 values can change within an episode of 
care. 
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To ensure that data can be entered out of sequence, the user is given the option upon exiting data entry to 
not update the patient tracked variable.  This exit is performed with warning messages.  Under normal data 
entry circumstances, the warning messages will not appear. 
 
For users upgrading to Version 6.0 or higher, the tracking items will be embedded in each existing 
assessment but will not yet be tracked for the patient.  Each time an assessment is opened for an existing 
patient, the tracking variables will be copied into the patient database where the items are blank at the 
patient level. 
 
If the most current tracked item value is already saved, the user is warned for confirmation purposes only 
when the user changes it. 
 
Finally, the tracked variables are copied into each assessment (as applicable) as the assessment is created.   
 
The process is designed to make it easier to track variables across assessments and only require a change 
when necessary.  
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HAVEN DATA EXPORT 

CREATE DIRECTORIES/FOLDERS FOR EXPORT 
 
It is strongly recommended that a separate directory from the installation directory be created for export files.   
The following instructions will enable a user to create a new directory/folder using Windows Explorer.  To 
access Windows Explorer, click on the <START> button in the lower left corner of the screen, select the 
Programs option, and then select the Windows Explorer option. 
 
After selecting the Windows Explorer option, add a new directory/folder to an available drive such as C.  
Click once on (C:) in the left window.  Next, click on the File menu, select the New option, and then select the 
Folder option.  After selecting the Folder option, a highlighted New Folder will be displayed at the bottom of 
the Name list in the right window. 
 
With the NEW FOLDER highlighted, left mouse click inside the highlighted frame and type in a name for the 
directory/folder.  Whatever is typed within the frame replaces the words “New Folder.“  After typing a name, 
press the <ENTER> key on the keyboard or left mouse click anywhere outside of the frame.   
 
To add a subdirectory/folder to an existing directory/folder (e.g., add a subdirectory named Export to 
HAVEN), click on (C:) in the left window and select the newly created folder (i.e., HAVEN) displayed under 
the Name list in the right window.  Next, click on the new folder (the right side of the screen should go blank) 
and repeat the instructions for adding a directory/folder. 
 
Exit Windows Explorer by clicking on the “X“ in the upper right corner of the screen or select the Close option 
from the FILE menu. 

EXPORT/LOCK ELECTRONIC FORMS 
 
To initiate the Export function, select either the Export option from the Options menu item or the <EXPORT> 
button on the HAVEN Management Screen. 
 
The HAVEN Export function enables users to export data for “Export Ready“ assessments from the HAVEN 
database into the Data Record Layout format (i.e., 1,448-byte string).  This format is suitable for submission 
to the state.  Note that each data field in each exported assessment has been error-checked in accordance 
with the rules specified in the HAVEN Data Record Layout. 
 
NOTE:  As of HAVEN 10.0, private pay assessments could no longer be exported from HAVEN.  After 
completion of data entry, these assessments are given a “:Completed” status and not included in the list of 
eligible assessments on the Export screen. 
 
Following is a description of the Export function. 
 

• Select the type of submission—New Export or Previous Export.  Resubmissions are described in the 
next section. 
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• Enter a description of the file into the Export Description text box.  (Optional—if left blank, the 
number of assessments exported will automatically be stored in the description). 

 
• Enter the path/file name into the Export Path and File Name text boxes.  Click on the <BROWSE> 

button and select a path, then enter a file name.  The data will be saved in text file format with file 
extension .txt.  The user may want the file name to correspond to the description used in the Export 
Description text box. 

 
• If applicable, select one of the Branch options to display assessments ready to export for the 

specified Branch value (same as the Branch options on the HAVEN Management Screen).   
 

• The assessments will be displayed in the Select Assessments to be Included in Export text box.  To 
select one assessment to export, highlight the desired assessment.  To select more than one 
assessment to export, use the <SHIFT> or <CTRL> keys.  To include all of the displayed 
assessments available for export, click on the <SELECT ALL> button.  To cancel the current 
selections, click the <CLEAR SELECTION> button. 

EXAMPLE: 
 
For easy reference, the user may wish to create a directory called EXPORT with subdirectories for 
the year/month.  This structure will help to organize the export files for submission to the State.  The 
saved file names could reference the weeks of the month (e.g., 
C:\EXPORT\2010\JANUARY\WEEK3.TXT).  Review the “Create Directories/Folders For Export“ 
section above for complete instructions on creating a directory/folder. 
 

• Select the type of submission—Production or Test.  For Production submissions, an assessment 
always receives the status “Exported“ once it has been exported.  The export header record contains 
a field called the Test/Production Indicator that identifies the type of submission. 

 
 
Click on the <EXPORT> button to complete the export process.  A message will be displayed stating that the 
export is complete and the file is ready to submit to the state.  Click on the <OK> button to close the 
message box.  After the export is completed, the batch of assessment submissions can be identified by the 
current date, file and path name, and the description of the exported file displayed in the Previous Exports 
text box.  Click on the <CLOSE> button to exit the Export function and return to the HAVEN Management 
window. 

RE-EXPORT ASSESSMENTS 
 
Users have the ability to re-submit previously exported assessments should an error be detected by the 
State System.  To do this, users select the Resubmission radio button and are presented with a list of 
previous batches of assessment submissions in the Previous Exports list box.  After selecting a previous 
batch, the user may then generate a new export file that contains the data for each of the assessments 
displayed in the Select Assessments to be Included in Export list box. 
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HAVEN DATA IMPORT  

PERFORM ERROR CHECK ON AN IMPORT FILE 
 
The System Administrator has the capability to import files.  Import files must utilize the same format as 
export files (i.e., they must contain a header record, assessments in the 1,448-byte string format specified in 
the HAVEN Data Record Layout, and a trailer record).  On the HAVEN Management Screen, the user may 
click on the <IMPORT> button or select the Import function from the Options menu item. 
 
After selecting the Import function, the HAVEN Import pop-up box will be displayed.  The user must use the 
<BROWSE> button to select the file path/name to be imported. 
 
The user may check the file for errors by clicking on the <ERROR CHECK> button.  Each record in the 
import file is processed in accordance with the rules specified in the HAVEN Data Record Layout.  When the 
error checking is complete, a message box will appear, giving counts of the records checked and errors 
found.  
 
Any errors or warning messages will be displayed in the HAVEN Errors/Warnings window.  From here, the 
errors can be printed.  Alternatively, the errors can be viewed with an external text editor – the errors are 
saved to the file ASMTERRS.TXT in the Import path directory.  (Note – if a specific Import path has not been 
specified in the Preferences section, ASMTERRS.TXT can be found in the application directory.) 
 

IMPORT HAVEN DATA 
 
The user may proceed with the import by clicking on the <IMPORT> button.  This action will process all 
records in the designated import file.  After the import has been completed, a message box will appear 
stating that the import is complete and displaying the number of assessments that were imported. 
 
Any errors or warning messages will be displayed in the HAVEN Errors/Warnings window.  From here, the 
errors can be printed.  Alternatively, the errors can be viewed with an external text editor – the errors are 
saved to the file ASMTERRS.TXT in the Import path directory.  (Note – if a specific Import path has not been 
specified in the Preferences section, ASMTERRS.TXT can be found in the application directory.) 

AGENCY DATA 
 
The Agency information in the header record is compared with the existing information in the agency 
database.  If the information does not match, the user is given the option to abort the import.  This action is 
useful if a wrong file is being imported.  It is recommended that assessments from different agencies not be 
mixed together in order to maintain the integrity of the export files. 
 
If the user continues with the import, he/she will be given the option to update the agency database.  If 
changes are made to any of the three agency fields (i.e., Agency State Assigned Unique ID, Agency 
Medicare Provider Number [M0010]; and Agency Medicaid Provider Number [M0012]) or copied from the 
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agency database into the assessment records, HAVEN will ask the user whether all non-exported 
assessments should be updated.  It is recommended that this update be completed to maintain the integrity 
of the export files. 
 
If an imported assessment contains new or updated agency or patient information, but the mandatory agency 
or patient fields are incomplete, then the assessment will not be imported.  The user will be notified that the 
agency or patient information was not added or modified and the assessment was not accepted.  New or 
updated information will also be rejected if it does not satisfy the consistency rules. 
 

BRANCH DATA 
 
If the imported assessment has any Branch Ids (M0016_BRANCH_ID) not in the Branch database, the 
Branch ID and its associated Branch State (M0014_BRANCH_STATE)  will be added during the import. 

PATIENT DATA 
 
The Patient information for each assessment in the import file is matched against the data in the existing 
patient database.  The software compares the following fields: 
 

• SSN, Date of Birth, Last Name, First Name, Gender; 
 

• SSN, Gender, Last Name; 
 

• Date of Birth, Last Name, First Name, Gender; 
 

• SSN, Date Of Birth, Gender; 
 

• SSN, Last Name, First Name, Gender;  
 

• Agency  ID, Date Of Birth (month and year only), Last Name, First Name, Gender; and 
 

• SSN, Date of Birth, Last Name, First Name. 
 
 
If a match is not found, a new entry will be added to the patient database.  For each assessment, HAVEN will  
display how the patient was matched.  The user can override this by checking the box “Do not display patient 
match information during import.“ 
 
By default, a message will be displayed when a new patient is added; however, the user can override this 
feature by checking the box labeled “Do not give warning message when new patient is added during 
import.“  This override is useful when importing assessments for a large number of patients who do not have 
previous patient database information in HAVEN. 
 
The patient information in the imported file is compared with the existing information in the patient database.  
If the information does not match, by default, the user is given the option to update the patient information in 
the patient database and the non-exported assessments.  However, the user can override this feature by 
checking the box labeled “Do not give warning message before updating patient information during import.“  
This override is useful when importing a large number of assessments that have non-static patient 
information. 



HAVEN Reference Manual:  October 1, 2010 HAVEN Data Import  45 

ASSESSMENT DATA 
 
Imported assessments may have a status of “In Use,” ” Export Ready,“ or “Exported.“ 
 
For an imported assessment to be “Export Ready“ or “Exported,“ the assessment must pass all error 
checking.  By default, assessments with no errors are assigned “Export Ready“ status. However, if the 
“Assign Exported status to assessments without errors“ checkbox is checked, then the assessments will be 
assigned “Exported“ status.  If the Lock Date is missing or invalid, the system will assign a Lock Date of the 
current date. 
 
All other assessments will be assigned the “In Use“ status. 
 
Duplicate assessments are identified during the import process and are not added to the HAVEN database.  
The following fields are used to identify duplicate assessments: 
 

• Agency State Assigned Unique ID; 
 

• Patient Information; 
 

• M0100_ASSMT_REASON; 
 

• M0030_START_CARE_DT; 
 

• Effective Date; and 
 

• Correction Number. 
 
Assessment sequencing rules are enforced in three areas of the software: 1) adding assessments, 2) 
correcting assessments, and 3) importing assessments.  Strong enforcement prohibits the import of 
assessments in an order that violates the sequencing rules.  If strong enforcement is disabled, then an 
assessment can be imported in an order that violates the sequencing rules.  Note that a modification or 
inactivation record can only be successfully imported if the assessment to be modified or inactivated already 
exists in the HAVEN database. 
 
If an ASCII file is created in a software package other than HAVEN, some variables, which should be empty, 
may contain data and therefore the assessment cannot be completed.  However, when a user tries to access 
one of these variables inside HAVEN to clear its value, the variable cannot be cleared, because it is 
disabled.  The Fix Inactive Fields feature discussed in the HAVEN Data Entry section can be used to clear 
these values. 
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REPORTS 

SELECT A REPORT TO VIEW/PRINT 
 
HAVEN provides the user with the following report options: 
 

• A report to view the data entry for one or more assessments (Assessment Data Entry Report); 
 

• A report to view all assessments with “In Use“ status (All Assessments In Use); and 
 

• A report to view masked values in Hex format for fields subject to protection (Masked Values in Hex 
Format). 

 
When the View/Print Reports function is selected, the user will be presented with a HAVEN Reports 
window where the report of interest can be selected. 
 
After selecting the report, click on the <OK> button to begin generating the report or, if applicable, go to the 
report specific selection criteria associated with the selected report. 

ASSESSMENT DATA ENTRY REPORT 
 
For quality control/review purposes, this report displays the data entered for an assessment(s). 
 
To report on an assessment(s), the user can: 
 

• Search for an assessment by Patient or Status (Export Ready, In Use, or Exported). 
 

• Patient.  Follow the instructions discussed in the HAVEN Data Entry section under Patient Info.   
 

• Status.  A list of assessments coded “Export Ready“, “In Use”, or “Exported” will be displayed in the 
assessment list box from which the user can choose.  If applicable, only assessments for the 
selected Branch will be displayed. 

 
• After making a selection, click on the <VIEW REPORT> button to produce the report(s) or the 

<EXIT> button to return to the HAVEN Management screen. 
 
NOTE:  A report can take some time to produce depending on the size of the database.  Also, if a large 
number of assessments exist in the system, it is not advisable to select all of the assessments at once 
because of the amount of time it takes to produce the reports. 

 
When the report has been produced, it will be displayed in the Report View window.  From there, the report 
can be printed or saved in several formats, including .PDF (Adobe Acrobat), .RTF (Rich Text Format), and 
.TXT (Text) format. 
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ALL ASSESSMENTS IN USE 
 
This report lists all assessments with an “In Use“ status.  Included in the report for each assessment is the 
Patient ID, Last Name, First Name, Medicare Number, Social Security Number, Medicaid Number, Reason 
for Assessment, Effective Date, and the Last User to access the assessment. 
 
From the Report View window, the user can print or save the report in several formats, including .PDF 
(Adobe Acrobat), .RTF (Rich Text Format), and .TXT (Text) format. 

MASKED VALUES IN HEX FORMAT 
 
When an assessment is masked, the masked values are written to a separate table.  This report lists the 
masked values in hex format along with the original unmasked values.  Assessments only contain masked 
values AFTER they have been exported. 
 
From the Report View window the user can print or save the report in several formats, including .PDF 
(Adobe Acrobat), .RTF (Rich Text Format), or .TXT (Text) format. 
 
 
NOTE:  As of HAVEN 10.0, private pay assessments were no longer masked.  However, this report remains 
in HAVEN for backward compatibility.
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APPENDIX A 

REPAIR/COMPACT UTILITY FOR MICROSOFT 
ACCESS DATABASE 
 
This utility module is named REPAIR32.EXE.  Use standard Windows procedures to execute this utility. 
 
IMPORTANT:  It is strongly recommended that the databases be backed up and archived before the 
Repair/Compact utility begins.  Not all damaged Access databases can be repaired and compacted 
by this or any repair/compact utility.  If a database is badly corrupted, data truncation may occur as 
the result of a repair and compact and data loss may result. 
 
IMPORTANT:  This function only works on a valid Microsoft Access 2.0, 95/97 or 2000/2002/2003 
database with an .“MDB“ extension.  Access 2007 databases are not supported. 
 
The Microsoft Access Databases Repair Utility is designed to fix a Microsoft Access database that becomes 
corrupted.  To use the Repair/Compact utility, select the file using the drive, directory, and file list boxes on 
the single window that comprises this utility.  The name of the selected file appears in the lower left portion of 
the window. 
 
The Repair/Compact function of the Repair/Compact utility tries to repair any index corruption attempts to 
recover from data loss, and compacts records on the selected database to recover space when records are 
deleted.  Since the size of the database files does not

 

 decrease when records are deleted from the 
database, it is recommended that this program function be used when a large number of records are deleted 
from the database. 

To begin the compacting process, select the database of interest by using the <BROWSE> button.  Then 
click on the <REPAIR/COMPACT> button.  If successful, the message “Repair and compact completed!“ is 
displayed; otherwise, an error message is displayed. 
 
The amount of time it takes to repair and compact depends on the size of the database and the speed of the 
computer.  To exit the Repair/Compact function, click on the <CLOSE> button. 
 
IMPORTANT:  Do not interrupt the repairing and compacting process.  An interruption may leave the 
database in an unstable state and could result in data loss. 
 
After repairing, compacting, and verifying that the records have been repaired and compacted properly, it is 
important that the user replace the working database with the repaired and compacted one since the 
replacement is not performed automatically. 
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GLOSSARY OF TERMS 

Data Entry 
 

A MedQuest function that allows users to collect data for the data entry system designed by the 
MedQuest Design function by creating the data store file called XXX.MDB, where “XXX“ represents the 
module acronym (e.g., HHA.MDB is the data store file for the data entry module HAVEN). 

 

Data Entry Rule 
 

A rule specified during the design process that is executed during data entry. 

 

Data Entry System 
 

A system designed by MedQuest to collect clinical data for a data analysis project.  Each project is called 
a Module and is represented by a three-character acronym (e.g., HHA is the Data Entry System for the 
OASIS Home Assessment Validation and Entry (HAVEN) System project). 

 

Edit 
 

The process by which data is modified.  This term can also be used to reference features performed on 
data to ensure the correctness and integrity of the modified data. 

 

Module 
 

See Data Entry System. 

 

Screen 

A screen is an area beneath the Go To dropdown box where variables are presented.  The variables on 
the screen are displayed by selecting a screen name in the Go To dropdown box. 
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Validation 
 

The process by which the integrity and correctness of data are established.  Validation processes can 
occur immediately after a data item is collected or after a complete set of data is collected. 

 

Variable 
 

A variable is a data entry field that accepts data according to the specifications and rules indicated by the 
designer during the design. 

 

Variable Type 
 

Variable types and attributes determine the type of data the system will accept (e.g., a variable will accept 
date format, etc.) during the data entry.  The designer defines a variable type for each variable.  For 
example, if variable Admission Date accepts only data that are in date form, the variable type must be 
defined as variable type Date. 
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